
 AN3346
 针对 Atmel Studio 和 ASF 用户的 MPLAB® X IDE 和 MPLAB

Harmony v3 介绍

摘要

本文档介绍 MPLAB® X 集成开发环境（Integrated Development Environment，IDE）和 MPLAB Harmony v3 框
架，带领用户入门适用于 32 位 Arm®

单片机的新工具和解决方案，并且可帮助 Atmel Studio、Atmel START 和 ASF 
用户熟悉 MPLAB X IDE 和 MPLAB Harmony v3。

本文档还将介绍 MPLAB X IDE 功能和 MPLAB Harmony v3 架构，并且会引用 Atmel Studio 或 ASF 中的等效功能来

帮助用户更好地理解。
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1. MPLAB X 集成开发环境（IDE）
MPLAB X IDE 是一款软件工具，可帮助用户开发基于 Microchip 单片机（MCU）和数字信号控制器的嵌入式应用程

序。MPLAB X IDE 可以安装在 Windows®、Linux®和 MAC 操作系统上。这有助于用户继续 MCU 的软件开发，而不受

操作系统的限制。

MPLAB X IDE 包含以下内容：

• 功能齐全的程序员友好型文本编辑器。

• MCU 固件开发所需的实用程序，例如编译器、汇编器和链接器。

• 包含一组功能强大的调试实用程序（例如断点、观察窗口和 I/O 视图）的调试器引擎。

• 可支持 IDE 和语言工具之间进行集成和通信的项目管理器。

• 软件模拟器。

• 插件（用以增加 MPLAB X IDE 的功能），安装后即可使用。

MPLAB X IDE 支持 Microchip 的各种 8 位、16 位和 32 位 MCU 产品组合。本文档专用于 32 位（Arm 和 PIC32）单片

机。如需确定是否支持某款特定的器件，请参见本文档参考资料部分列出的器件支持文档。

1.1 安装和工具链
要安装 MPLAB X IDE，用户需要从 Microchip 网站下载相应的安装程序并按照提示进行操作。MPLAB X IDE 是基于

NetBeans 的平台。

MPLAB X IDE 的工具链必须单独安装，因为它并没有与 MPLAB 安装程序捆绑在一起。这样，用户便可灵活选择安装

基于 MPLAB XC8、MPLAB XC16 或 MPLAB XC32 的编译器（或安装全部三个编译器）。

MPLAB XC8 支持所有 8 位 PIC®
和 AVR® MCU。MPLAB XC16 支持所有 16 位 PIC MCU 和 dsPIC®

数字信号控制器

（Digital Signal Controller，DSC）。MPLAB XC32/32++支持所有 32 位 PIC 和 SAM MCU。

注： 在 Atmel Studio 中，工具链的安装方式有所不同。Atmel Studio 安装程序包与用于 AVR、AVR32 和 SAM 器件的

工具链捆绑在一起，用户可以在安装 Atmel Studio 时选择所需的工具链。因此，与 Atmel Studio 不同，MPLAB X IDE
用户必须单独安装 MPLAB XC8、MPLAB X16 或 MPLAB X32 编译器。

1.2 许可
工具链（MPLAB XC8、MPLAB X16 或 MPLAB X32）具有针对代码长度和速度的基本优化功能，并且还提供 60 天的

免费试用许可证。如果软件开发需要高级优化，则可以使用专业版许可证来解锁 MPLAB XC C 编译器的全部功能。如

需关于灵活许可选项的列表，请访问 Microchip 网站获取。

注：

1. Atmel Studio 随附免费的标准 Arm GNU C 编译器。

2. MPLAB X IDE 中提供免费的 C++许可。

1.3 用于安装器件系列包（Device Family Pack，DFP）的 MPLAB 包管理器

MPLAB 包管理器可以在 MPLAB X IDE 中添加或删除器件支持。使用包管理器添加新版 DFP 或新器件支持后，便无需

从头安装 MPLAB X IDE。这样，无需对 MPLAB X IDE 进行补丁，或者仅需较小的安装程序来补丁少量文件。

要打开 MPLAB 包管理器，可从 MPLAB X IDE 中选择 Tools > Packs（工具 > 包）。

注： 处理器件包的方式与 Atmel Studio 类似。

1.4 主要特性
MPLAB X IDE 的主要特性如下：
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• 同一项目有多种配置：

– 一个项目可以通过多种方式编译相同的源文件集。每种配置都有其自己的编译器选项、硬件工具和目标器
件。

• 支持同一编译器的多个版本。

• 智能文本编辑器，具有以下特性：

– 提供自动补全功能

– 使用本地历史记录跟踪系统内的更改

– 用户可以配置所需的代码格式样式

• 可自定义工作区并支持多屏显示：

– 任务窗口

– 导航窗口

– 项目状态窗口

– 软件调用堆栈窗口

• 使用 MPLAB X IDE 插件管理器扩展 MPLAB X IDE 功能。

1.5 编程和调试单片机

MPLAB X IDE 支持 Microchip 的各种编程和调试工具，具体可参见参考资料部分列出的器件支持文档。

用户可以选择以下任一方式在 MPLAB X IDE 中启动调试会话：

• 单击 （调试运行）图标。

• 从工具栏中选择 Debug > Debug Main Project（调试 > 调试主项目）。

注： 如果在 MPLAB X IDE 中打开了多个项目，则设为主项目的项目将作为调试会话的目标。

在调试会话期间，MPLAB X IDE 中提供以下调试所需的基本功能和高级功能：

• 单步进入、单步跳过、单步跳出和运行到光标处。

• 设置断点。

• 保持复位，运行。

• 在 Watch（观察）窗口中查看变量。

• 在 I/O 视图中显示器件外设寄存器内容。

• 在 Memory（存储器）视图中显示器件的存储器内容。

• 需要指令级调试时提供代码的反汇编视图。

注： 支持软件模拟器的器件不是很多。更多信息，请参见 7.  参考资料部分列出的器件支持文档。

1.6 MPLAB X IDE 插件

通过添加插件，可以扩展 MPLAB X IDE 的功能。用户可以根据自己的应用需求选择功能。有些用户可能只需要使用高

级功能，但并非所有用户都会使用 Motor Bench 开发套件、RTOS 查看器、电源监视器、MPLAB Data Visualizer 等，

因此这些功能以插件形式提供。这样一来，既可以减小 MPLAB X IDE 占用的存储空间，也能够防止用户装载整个功能

集，从而降低 PC 的存储器和带宽需求，改善工具的用户体验。

注： MPLAB X IDE 插件相当于 Atmel Studio 中的扩展项。

1.7 MPLAB Harmony v3 插件

本文档重点介绍 MPLAB Harmony 配置器 v3 插件，该插件在 MPLAB X IDE 中集成了 MPLAB Harmony v3 软件开发

框架。
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安装 MPLAB Harmony Configuration v3 插件时会将 MPLAB Harmony 配置器（MPLAB Harmony Configurator，
MHC）和 MPLAB Harmony 框架下载器工具添加到 MPLAB X IDE。这些工具可以从 Tools > Embedded（工具 > 已安

装工具）启动。MPLAB Harmony 框架下载器工具有助于从 Microchip MPLAB Harmony GitHub 链接中克隆 MPLAB
Harmony v3 资源库。本文档将详细介绍使用 GitHub 分发和资源库结构的内容交付。

注： MPLAB Harmony v3 是一款灵活的全集成嵌入式软件开发框架，适用于 32 位单片机（MCU）和微处理器

（MPU）。
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2. MPLAB Harmony v3 软件开发框架
以下各节将详细讨论 MPLAB Harmony v3 架构。

2.1 MPLAB Harmony v3 简介

MPLAB Harmony v3 与 MPLAB X IDE 配合使用时，可通过简单且用户友好的外设库（PLIB）、抽象驱动程序和模块

化软件下载来改善应用程序开发体验。

MPLAB Harmony v3 包括 MPLAB Harmony Configurator（MHC）工具、一组模块化器件和中间件库以及大量示例应

用程序，旨在帮助针对 Microchip 的 32 位 PIC 和 SAM 单片机开发功能强大且高效的嵌入式软件。

MPLAB Harmony v3 的主要特性如下：

• 适用于 32 位 PIC、SAM MCU 和 MPU 的统一软件开发框架。

• MHC GUI 工具可简化硬件组件的配置，例如时钟、引脚、中断、ADC、DMA、存储器保护单元（Memory
Protection Unit，MPU）。

• 框架下载程序可简化下载固件库、演示应用程序和 MHC GUI 扩展项的过程。

• 简单且用户友好的轻量级外设库（PLIB）。

• 模块化且可互操作的驱动程序和系统服务。

• 一组丰富的中间件。

• 支持 RTOS 和其他第三方库。

• 灵活的固件设计模型。

MPLAB Harmony v3 采用分层架构，由若干个软件模块组成。这些模块可移植且彼此兼容，能够互相通信及交换数据

和信息。下图给出了 MPLAB Harmony 架构。

图 2-1. MPLAB Harmony 架构

• PLIB：该层最接近硬件，不进行无抽象化和直接寄存器访问。

• 驱动程序：该层是在 PLIB 的基础之上编写的软件外设驱动程序。

注： 在 MPLAB Harmony v3、ASFv3 和 Atmel START 中，术语“驱动程序”具有不同的含义。MPLAB
Harmony v3 驱动程序本质上十分丰富，从硬件中抽象化，而 ASFv3 驱动程序几乎不需要软件处理并且支持完整

的硬件访问。Atmel START 驱动程序分为 HAL、HPL 和 HRI 层。
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• 系统配置：系统服务管理共享的系统资源。这些资源可由驱动程序、中间件或应用程序使用，例如定时器服务、

调试控制台、时钟和 DMA 配置。

• 中间件：中间件通常由涉及使用协议（有时与 IEEE®
标准有关）的软件组成，例如 USB 软件协议栈、TCP/IP 网

络协议栈、图形协议栈、蓝牙和其他无线协议栈。

• 第三方库：由几个 RTOS 选项、Segger 的图形协议栈、安全套接字层（Secure Socket Layer，SSL）、传输层

安全（Transport Layer Security，TLS）和 WolfSSL Inc®
的加密库组成。

• 插件：自定义蓝牙配置文件或 USB 功能类以插件形式提供。例如，USB 协议栈即属于插件。

• MHC：一款用于配置 MPLAB Harmony v3 项目并生成代码的 GUI 工具。用户可根据其应用需求配置时钟、引脚

和外设等并生成代码。随后，PLIB 和驱动程序的内容可能会根据配置发生变化。代码渲染或代码生成是 MHC 的

一部分，用于维护驱动程序和避免出现不需要的代码。

2.2 模块化下载和资源库结构
Microchip 在 GitHub 上维护了一个资源库，用以提供 MPLAB Harmony v3 资源库的目录。MHC 下载管理器将读取此

目录并下载用户所选的库包（和其他内容）。MHC 随后在本地进行克隆，以使其包含在项目中。

与基于安装程序的典型内容交付相比，通过 GitHub 分发 MPLAB Harmony v3 软件框架极具优势。每次运行安装程序

时，基于安装程序或 zip 文件的内容交付都将安装全套框架源文件。Git 将仅更新对每个文件所做的更改，从而简化内

容交付并降低每次安装大量文件所需的带宽。

注： 用户必须知道其应用需要哪些资源库。了解资源库的结构将帮助用户理解其需求。

MPLAB Harmony v3 资源库如下：

• bootloader
• wolfSSL
• wolfSSH
• touch
• USB
• Crypto
• core
• bsp（板级支持包）

• csp（芯片支持包）

• dev_packs
• wolfMOTT
• mhc
• smartenergy_plc
• motor_control
• gfx_apps
• gfx
• audio
• bt
• net
• at91bootstrap
• micrium_ucos3
• CMSIS-FreeRTOS（来自 Arm GitHub）

要启动 MPLAB Harmony v3 框架，需要以下资源库。

• dev_packs 资源库：包含将在代码生成期间使用的（每个器件特定的）ATDF 文件、器件头文件和外设头文件。

ATDF 文件包含 XML 标记和与器件硬件有关的信息。MHC 使用 ATDF 文件中的信息在硬件级生成有效代码。

• 芯片支持包（csp）资源库：包含外设库（PLIB），以及将 PLIB 用于支持的所有外设的应用程序演示。PLIB 的

编写方式使其无需任何抽象化即可与硬件通信。csp 资源库具有以下结构：
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– apps/：此文件夹包含 MPLAB Harmony v3 支持的所有器件中几乎所有外设的 PLIB 演示。每个外设可以有

多个 PLIB 演示。

– peripheral/：此文件夹包含 MPLAB Harmony v3 支持的所有器件中几乎所有外设的 PLIB。
– arch/：此文件夹包含基于 MCU 架构的器件支持软件逻辑。MPLAB Harmony v3 支持基于 Arm Cortex

M0+、M4、M7、Cortex A5 和 MIPS 架构的器件。

– doc/或 docs/：这两个文件夹包含 PLIB 和 PLIB 演示的帮助文档。

提示： 在 csp 资源库和 apps 文件夹中，文件夹名称与数据手册中的外设名称相同。例如，通用 I/O 端口在

不同器件系列中的命名不同。在一些器件中，I/O 外设的名称为 GPIO；而在另一些器件中，I/O 外设的名称

为 PIO 或 PORT。因此，csp 和 apps 文件夹具有三个不同的文件夹，名称分别为 GPIO、PIO 和 PORT。
用户应查看器件数据手册，并根据数据手册中的外设名称导航至相应文件夹。这将有助于确定外设的正确演

示。

• Core 资源库：此资源库包含驱动程序和服务，这些驱动程序和服务基于所开发的中间件和应用程序对外设和共享

资源进行用户友好的抽象化操作。驱动程序和服务可提供高级功能，例如缓冲区排队和外设共享。core 资源库还

提供操作系统抽象层（Operating System Abstraction Layer，OSAL）。MPLAB Harmony v3 支持多个第三方实

时操作系统（Real-Time Operating System，RTOS）。Harmony 驱动程序、服务和中间件使用 RTOS 特定的方

法来确保线程安全操作和 RTOS 兼容性。要使用 RTOS 特定的方法，Harmony 库必须为每个受支持的 RTOS 调

用不同的函数。为此，MPLAB Harmony v3 定义了操作系统抽象层（OSAL）。OSAL 是一个轻量级的 OS 兼容

层，它抽象出了 RTOS 特定的细节，并提供了一组一致的函数，MPLAB Harmony 库可以调用这些函数来获得保

护共享资源所需的 RTOS 特定功能。

core 资源库具有以下结构。

• apps/：此文件夹包含驱动程序（I2C、SPI 和 USART 等）、文件系统、FreeRTOS 和系统定时器服务等核心组件

的示例。

• driver/：此文件夹包含适用于 I2C、USART、SPI、SDMMC、SDSPI 和存储器的 MPLAB Harmony v3 驱动程

序。这些驱动程序在 PLIB 的基础之上编译。

• osal/：此文件夹包含受支持 RTOS 顶部的包装层。

• system/：此文件夹包含系统服务，例如 DMA、虚拟文件系统、中断、I/O 端口、调试控制台、命令控制台、定时

器和随机数。

• doc/或 docs/：这两个文件夹包含核心组件和演示的帮助文档。

• 板级支持包（bsp）资源库：bsp 资源库包含板特定的信息，其中包括 I/O 引脚的详细信息，例如板上与 I/O 连接

的 LED 和开关。

2.3 灵活的固件设计模型
MPLAB Harmony v3 架构可实现各种应用，从小型实时应用到功能丰富的大型应用，无所不包。

MPLAB Harmony v3 支持以下设计模型：

• 使用 MHC 进行简单的器件配置和初始化

• 基于外设库的项目

• 基于驱动程序的功能强大且无冲突的项目

• 需要 MPLAB Harmony 中间件的项目

• 可优化中央处理器（Central Processing Unit，CPU）利用率的基于 RTOS 的项目

MPLAB Harmony v3 库随软件包提供，并在 GitHub 的 GIT 资源库中进行维护。MPLAB Harmony v3 芯片支持包

（Chip Support Package，CSP）仅基于相应的器件系列包（Device Family Pack，DFP）以及标准的“C”库和工具

来支持简单的器件初始化和基于 PLIB 的项目，而与外部模块和组件无关。需要从硬件、操作系统支持或强大中间件功

能中抽象化的高级项目将依赖于 MPLAB Harmony v3 核心包。
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图 2-2. MPLAB Harmony v3 库

Harmony CSP, Core, & Middleware

Harmony Core & Middleware PackagesChip Support Package (CSP)

PLIB‐based & minimal configuration applications 
are supported by the CSP module (plus device 
pack support).

Harmony driver, service, middleware, and RTOS‐
based applications require Harmony core and 
other modules.

Simple 
Projects

Advanced 
Capabilities

2.4 高级软件框架 v3 和 Atmel START 架构
Atmel START（ASFv3）：高级软件框架（Advanced Software Framework，ASF）提供用于为 Atmel megaAVR®

、

AVR XMEGA®
、AVR UC3 和 SAM 器件构建应用程序的软件驱动程序和库。ASF 旨在帮助开发和整合软件设计的不同

组件。

ASF 文件夹根据器件系列分为六个子文件夹。下面列出了 ASF 根文件夹的内容：

• avr32/
• common/
• mega/
• sam/
• thirdparty/
• xmega/

每个架构文件夹和公共目录都分为几个子目录，这些子目录中包含各种模块、板、驱动程序、组件、服务和实用程

序。以下子目录概述了各种模块之间如何关联。

• applications/
• boards/
• components/
• drivers/
• services/
• utils/

Atmel START（ASFv4）：这是新一代 ASF，旨在作为基于 Web 的用户界面与 GUI 搭配使用，从而方便配置和使

用。与 ASFv3 相比，ASFv4 对整个框架进行了完全重新设计与实现。重新设计即指对架构进行了重大更改。驱动程序

变为用例驱动程序，文件夹结构则针对这一全新架构进行了适应性修改。驱动程序层分为硬件抽象层（Hardware
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Abstraction Layer，HAL）、硬件代理层（Hardware Proxy layer，HPL）和硬件寄存器接口（Hardware Register
Interface，HRI）层。HAL 仍是不同器件中的常用层，HPL 和 HRI 则随使用的硬件而异。

图 2-3. MPLAB Harmony v3、ASF3、ASF4 和 Atmel START 架构概览

SAM

ASF3 ASF4

CMSIS/DFP

Driver

[Services]

Application

CMSIS/DFP

HRI

HPL

[Abstract 
Device]

HAL

[Simple 
I/O]

[Middleware]

Application

PIC32M, SAM

Harmony 3 / MHC 3

CMSIS/DFP

PLIB

[Driver]

Application

[Middleware]=

≈

≠

[Driver] ==  optional

[Middleware] ==  optional

表 2-1. MPLAB Harmony v3、ASFv3 和 Atmel START 架构信息

Harmony v3 Atmel START ASF v3

配置特定的代码生成 支持 支持 不支持

可以获得独立项目 支持
不支持（使用 Atmel Studio 中

的原生头文件）
支持

GUI 辅助工具 支持 支持 不支持

其他工具链支持 支持（IAR） 支持（IAR 和 Keil makefile） 支持（IAR）

模块化下载 支持（基于 GitHub） 支持（单个项目） 不支持

基于云的工具 不支持 支持 不支持

与 IDE 集成 支持（MPLAB） 支持（Atmel Studio） 支持（Atmel Studio）

框架以独立 zip 形式提供 不支持 不支持 支持

内容分配
GitHub 资源库（将在本地克

隆）
云端

Atmel Studio 安装的一部

分

外设驱动程序模型 外设配置特定（PLIB） 用例特定 完整的通用驱动程序
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...........（续）

Harmony v3 Atmel START ASF v3

提供业务逻辑 支持 不支持 不支持

原生编译器支持 XC32 编译器 GCC GCC

2.5 MPLAB Harmony v3 中的外设库（PLIB）的意义
这是器件外设的最低级别接口。它被命名为库，但由源文件（.c）和头文件（.h）组成。通常，每个外设实例都有与

其关联的源文件和头文件。应用程序接口（Application Program Interface，API）的实现应保持简单化，确保大部分实

现将是直接外设寄存器访问。

不同器件的大多数 API 名称和结构都是一致的，这有助于实现驱动程序可移植性。通常，驱动程序层使用 PLIB API 调
用。因此，PLIB 与外设密切相关，并且因器件而异。大多数 PLIB 可以在轮询模式或中断模式下使用。为了实现轮询

模式，PLIB 采用阻断调用。中断模式支持 ISR 功能（支持回调）。PLIB 中没有错误检查、工作状态检查和状态维

护。为了提高可读性，PLIB 采用干净的代码，没有条件宏（#if 和 #elif.）。

表 2-2.基本 PLIB API 可用性示例

使用 UART SPI I2C/TWI

初始化 UARTx_Initialize() SPIx_Initialize() TWIx_Initialize()

事务

UARTx_Write() SPIx_Write() TWIx_Write()

UARTx_Read() SPIx_Read() TWIx_Read()

- SPIx_WriteRead() TWIx_WriteRead()

状态
UARTx_ReadIsBusy()

SPIx_IsBusy() TWIx_IsBusy()
UARTx_WriteIsBusy()

2.6 Harmony 驱动程序的优势
MPLAB Harmony 驱动程序提供抽象化的接口来访问硬件，从而支持跨平台移植应用程序和中间件。当需要跨硬件平

台移植软件时，这是访问外设的首选方法。

MPLAB Harmony 驱动程序的主要特性如下：

多客户端操作
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图 2-4. 多客户端操作

I2C‐1

Sensor EEPROM

Application
(Client 1)

Application
(Client 2)

Harmony Driver
(I2C)
Driver 

Instance 0

Client-1 Config Client-2 Config

当应用程序中的两个不同客户端访问外设的同一实例时，驱动程序必须能够访问正确的传感器以将数据提供给正确的

客户端。MPLAB Harmony v3 驱动程序能够处理这种多客户端情形。

多实例操作

在多实例情形中，同一驱动程序（代码）能够处理外设的多个实例。应用程序客户端可以调用同一驱动程序函数来对

相应的外设实例执行作业。
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图 2-5. 多实例操作

I2C‐1 I2C‐2

Sensor EEPROM

Application
(Client 1)

Application
(Client 2)

Harmony Driver
(I2C)

Driver 
Instance 0

Driver 
Instance 1

Client-1 Config Client-2 Config

• 外设的所有实例使用相同的 API：
– 外设实例发生更改后，应用程序保持不变

I2C 驱动程序 API I2C PLIB API

DRV_I2C_WriteTransferAdd(...) I2C1_Write(...)

I2C2_Write(...)

DRV_I2C_ReadTransferAdd(...) I2C1_Read(...)

I2C2_Read(...)

• DMA 传输模式支持——无论是否支持 DMA 传输模式，驱动程序接口或 API 均保持不变

• 缓冲区/队列支持

• 错误校验

• 工作状态检查

• RTOS 就绪

• 线程安全

驱动程序不会使用阻断 API。MPLAB Harmony v3 中提供 sync 和 async 两种驱动程序。

Harmony v3 驱动程序：

MPLAB Harmony v3 驱动程序分为以下两种：异步（async）和同步（sync）。驱动程序的详细信息如下：

• 异步（async）
– 非阻断 API
– 在裸机和 RTOS 环境中无缝运行

– 中断和线程安全
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• 同步（sync）
– 阻断 API
– 适用于 RTOS 环境

– 中断和线程安全

注： MPLAB Harmony v3 中的术语“sync”和“async”的含义与 Atmel START 中不同。在 Atmel START 中，可用

的驱动程序类型为 sync、async 和 RTOS。sync 表示轮询的驱动程序，async 表示基于中断的驱动程序，而 RTOS 驱

动程序表示与 RTOS 兼容的驱动程序。

2.7 中间件支持
MPLAB Harmony v3 中间件提供支持关键技术的复杂软件库，例如行业领先的图形、具有广泛协议支持的 TCP/IP 网

络、用于最常用设备类别的 USB 主机和设备功能以及加密功能等。这些软件库建立在 MPLAB Harmony v3 驱动程序

和服务的基础之上，因此该中间件可与所有受支持的 Microchip 32 位器件一起使用，同时仍允许直接访问 MPLAB
Harmony 库未使用的外设。

图 2-6. 支持的中间件

Middleware

• Wi‐Fi
• wolfSSL
• TLS
• Crypto
• DSP
• Boot

• BT/BLE Data, A2DP, Voice,…
• Audio Encoders, Decoders, MFi,…
• Multi‐lingual GUI Support
• File Systems: FATFS, MPFS
• Flash Media: NVM, SQI, SPI,

SD Card, USB Stick
• Touch: Screen, Capacitive Button

Math
• Basic
• Fast
• Complex
• Filtering
• Matrix
• Transforms

注： 有关所支持中间件的详细信息，请参见参考资料部分。

2.8 操作系统抽象层
MPLAB Harmony v3 支持多个 RTOS。每个 RTOS 都有自己的 API 调用，用以创建任务以及运行调度程序、信号量或

互斥处理。为了使 MPLAB Harmony v3 驱动程序在非 RTOS 环境（BareMetal）中以及在不同 RTOS 中兼容，

MPLAB Harmony v3 提供了一个称为操作系统抽象层（Operating Systems Abstraction Layer，OSAL）的抽象层。

OSAL 支持一个从许多不同的 RTOS 产品中抽象化的最基本功能集，以实现最大的兼容性。OSAL 的重点是提供在多

线程环境中安全运行库所需的一组最基本机制。
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OSAL 的主要特性

OSAL 的特性如下：

• 互斥：用于管理资源所有权，因此一次只能由单个线程单独访问。

• 信号量：主要用于在不同线程之间进行同步。

• 临界区：用于保护一段代码，因此必须以原子方式执行（不中断或不可分割）。

• 存储器分配：用于支持 RTOS 特定的存储器管理（如果没有 RTOS 特定的存储器管理，则抽象化 malloc和

free）。

• 初始化和信息：OSAL 支持和 OS 信息。

图 2-7. OSAL 和 RTOS 映射

Driver Function

At some point, the driver 
function calls 
OSAL_SEM_Pend()

OSAL_SEM_Pend

Express Logic - ThreadX

tx_semaphore_get()

Micrium – uC/OS-III

OSSemPend()

FreeRTOS/OPENRTOS

xSemaphoreTake()

OSAL call maps 
(statically) to API of 
RTOS used in the 
project.

Driver Function

Call returns when resource 
is available, letting driver 
function resume.

Driver call will block, if 
resource not immediately 
available.

Time
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3. MPLAB Harmony v3 GitHub 资源库处理
MPLAB Harmony v3 必须与 MPLAB X IDE 搭配使用。安装 MPLAB X IDE 之后，必须安装 MPLAB Harmony
Configurator v3 插件。安装该插件后，即可使用 MPLAB Harmony 3 内容管理器和 MPLAB Harmony 3 配置器。

重要的变化是 MPLAB Harmony v3 的内容现在通过 GitHub 提供。MPLAB Harmony 3 内容管理器有助于将公共

GitHub 资源库克隆到 PC。用户可以选择要克隆的资源库。克隆资源库后，用户可以定期更新内容，以便与云端的主

分支保持同步。

3.1 使用 MPLAB Harmony 3 内容管理器下载软件包
通过使用 MPLAB Harmony 3 内容管理器，用户可以在 MPLAB X IDE 中下载软件包。下载软件包时需遵循以下步骤：

1. 安装 MPLAB Harmony 配置器 3 插件后，启动 MPLAB X IDE。
2. 选择 Tools > MPLAB Harmony 3 Content Manager（工具 > MPLAB Harmony 3 内容管理器）。随即将显示

MPLAB Harmony Content Manager 窗口。该窗口具有以下两个选项卡：

2.1. Content Manager（内容管理器）——有助于从远程 GitHub 下载和更新 MPLAB Harmony 资源库。用

户可以从 GitHub 下载所选的资源库。

2.2. Application Browser（应用程序浏览器）——有助于下载所有可用资源库中提供的应用程序演示项目。

用户可以下载所选的示例项目。

图 3-1. MPLAB Harmony 3 内容管理器

3. 打开 MPLAB Harmony 3 内容管理器时，请指定克隆框架资源库所使用的路径。

注： 首次克隆时，MPLAB Harmony 3 内容管理器将在公共 GitHub 链接中列出所有可用的资源库。用户可以选

择所需的资源库，然后单击 Download（下载）将所选资源库克隆到 PC。之后，如果 Microchip 有添加新的资

源库，则 MPLAB Harmony 3 内容管理器会将其列出。用户可以根据需要选择新添加的资源库进行下载。

3.2 使用 MPLAB Harmony 3 内容管理器更新资源库
下载资源库之后，MPLAB Harmony 3 内容管理器将查询 PC 上分支的标签信息以及 Web 上提供的相关信息。如果

Web 上具有较新的版本，则用户可以更新相应的资源库。

如果用户已修改资源库（例如更改配置），则可以使用 MPLAB Harmony 3 内容管理器清除资源库，然后更新资源

库。
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图 3-2. 更新资源库

提示： 由于 Internet 链接强度和服务器响应速度各不相同，因此该步骤可能需要花费一些时间。
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4. MPLAB X IDE 和 MPLAB Harmony v3 之间的集成
MPLAB Harmony v3 框架配置器将启动 MPLAB Harmony v3 框架开发环境。

4.1 MPLAB Harmony v3 用户界面
图形用户界面（Graphical User Interface，GUI）是 MPLAB Harmony v3 的其中一项重要功能，有助于简化 MCU 功

能的配置过程。下面列出了 MHC GUI 下的一些 GUI 窗口示例：

• 项目图

• 时钟管理器

• 引脚管理器

• NVIC 管理器

• DMAC 管理器

• ADC 管理器

• PTC 管理器

• Motor-bench 套件

项目图显示项目中使用的所有模块以及它们之间的连接，以此直观呈现这些模块之间的依赖关系。同样，其他 GUI 窗
口在配置相应模块时也非常实用。

配置这些模块时，除了使用上述简单易用的 GUI 之外，还可以使用基本的 UI 配置树。使用 UI 配置树时，用户需要多

加了解相关硬件，以便在树形视图中正确配置。

例如，许多 SAM 器件在时钟配置方面有很大的灵活性。如果用户必须在不使用时钟管理器的情况下配置时钟，则应事

先充分了解 MCU 的时钟分配，然后再使用 UI 配置树配置时钟。

MHC 中的时钟管理器 GUI 对于配置时钟很有帮助，它可以在 UI 上直观地呈现时钟树、状态和值（类似于数据手册中

提供的时钟分布图）。因此，用户可以轻松完成配置。时钟管理器显示 CPU、其他时钟值和时钟屏蔽状态。如果时钟

屏蔽、DPLL 比或预分频值有任何变化，时钟管理器会相应地更新时钟和状态的值，并显示当前值。

图 4-1. 时钟管理器（MHC > 工具 > 时钟配置）

此外，引脚管理器、NVIC 管理器和 ADC 管理器等其他 GUI 同样可以简化配置。
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注： Atmel START 中的时钟、PINMUX 和 QTouch®具有类似的 GUI。熟悉 Atmel START GUI 的用户会觉得 Harmony
v3 GUI 对用户很友好。此外，MPLAB Harmony v3 还有更多可简化外设配置的 GUI，例如 DMAC、NVIC 和事件系统

管理器。

4.2 MPLAB Harmony v3——探究 PLIB 演示项目
安装 MPLAB X IDE 和 MPLAB Harmony v3 配置器后，用户可以打开任意一个 PLIB 或核心演示示例 MPLAB
Harmony v3 项目。

从一个简单的项目开始探究示例 PLIB 演示项目。本小节将帮助用户打开 PLIB 演示、使用 MHC 和探究项目窗口以熟

悉程序。

1. 启动 MPLAB X IDE。
2. 从工具栏中，选择 File > Open Project（文件 > 打开项目）。

3. 转到下载 csp资源库所使用的路径。

4. 转到 apps。
5. 在 apps文件夹中，通过 port > port_led_on_off_polling > firmware > select project（端口 > 端口 LED 开关轮

询 > 固件 > 选择项目）为用户选择的任何板选择一个示例外设。

在执行该步骤之前，只打开 MPLAB Harmony v3 项目，而不打开 MPLAB Harmony 配置器。打开 MPLAB Harmony 3
项目后，转到 MPLAB X IDE > Tools > Embedded > MPLAB Harmony Configurator（MPLAB X IDE > 工具 > 已安装

工具 > MPLAB Harmony 配置器）。下图显示了在 MPLAB X IDE 中随 MPLAB Harmony 配置器（MHC）一起打开的

MPLAB Harmony v3 项目。

图 4-2. 打开 MHC 时的项目窗口

Available 
Components

Active 
Components

Project 
Graph

Console

Tree view 
Configuration

4.3 Harmony v3 项目文件夹结构
下图显示了 MPLAB Harmony v3 中 PLIB 项目的结构。
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图 4-3. MPLAB Harmony v3 PLIB 项目文件夹结构

Exceptions
 Implements all exception handlers

Initialization
 Initializes the system and peripheral libraries

Interrupt Vectors
 Contains the interrupt vector table

System prototypes and definitions
 Includes all library headers and

definitions needed for the system

Peripheral Libraries
 Contains the peripheral logic

Startup 
 Contains the C startup code

Device Family Pack (DFP)
 Provided by Microchip. Product specific

information

CMSIS
 Provided by ARM. Core specific information.

4.4 编译、编程和调试 PLIB 演示项目
打开的 PLIB 演示项目可以按原样进行编译和编程。资源库中提供的所有 PLIB 演示都应按原样进行编译，而无需重新

生成项目。要编译和编程 PLIB 演示，用户必须选择要与该项目一起使用的 DFP、编译器工具链和硬件工具（该工具必

须连接到 PC）。

1. 右键单击项目，并选择 Properties（属性）。

2. 在 Project Properties（项目属性）窗口的 Categories（类别）下，选择 Conf（sam_v71）。

3. 在 Configuration（配置）部分，选择 DFP、硬件工具和编译器工具链版本（如果安装了多个版本），以在器件

中编译并编程项目。
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图 4-4. Project Properties 窗口

可以在 Project Properties 窗口中更改以下选项：

– 常规文件包含、文件排除和宏添加

– XC32 编译器设置，例如优化、预处理设置、消息设置以及其他可选的编译器开关

– 常规链接器设置、链接器符号和宏以及链接器开关

– XC32 汇编器选项

– 调试器编程选项、要编程的存储器和调试通信接口速度

4. 单击 （Make and Program Device（编译并编程器件））按钮，编译项目并使用编译器代码编程器件。

5. 要启动调试会话，应从 MPLAB X IDE 中选择 Debug > Debug Main project（调试 > 调试主项目）或单击

按钮。这样，用户便可调试项目。

4.5 为 PLIB 演示修改组件和配置并重新生成代码
要修改或更改项目图中的外设，用户必须先打开 MPLAB Harmony 配置器。打开 Harmony 配置器后，用户就可以在项

目图中添加或删除任何外设。在树形视图中，根据应用程序的需要更改所包含外设的配置，然后重新生成代码。

要为新配置重新生成代码，应单击 （Generate Code（生成代码）图标）或转到 MHC > Generate Code
（MHC > 生成代码）。在重新生成新代码之前，MHC 会显示因重新配置而需要更改（逐行）的文件。用户可以根据

结果来选择接受或拒绝更改（逐行）。

 AN3346
MPLAB X IDE 和 MPLAB Harmony v3 之间的集成

© 2020 Microchip Technology Inc.  应用笔记 DS00003346A_CN-第 22 页



图 4-5. 逐行更改

注： 如需查看 MHC 对每个文件所做的更改，此选项会很有用。

提示： 要使能此选项，应在 MPLAB X IDE 中更改以下设置：

在重新生成代码时，合并窗口中的默认选项为 USER_ALL。此选项应更改为 ALL。USER_ALL 表示对

Harmony 3 框架文件进行更改时不会提示用户。ALL 则表示对所有文件（包括 Harmony 3 框架文件）进行

更改时会提示用户。
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图 4-6. 将合并策略从 USER_ALL 更改为 ALL

4.6 Harmony v3 服务——标准 I/O（STDIO）和工具链支持
Harmony v3 支持标准 I/O（STDIO）。使用 STDIO 模块，用户可以通过硬件中的 USART 模块使用标准的 printf和

scanf。
同样，使用 IAR IDE 的用户可以利用 IAR 工具链生成项目。在 Project graph > System module（项目图 > 系统模块）

中，可以使用工具链的器件和项目配置设置。目前可以使用 XC32 和 IAR。
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图 4-7. 工具链选择

选择 IAR 工具链时，ipcf文件将与项目文件一起生成。

注： 熟悉 Atmel START 中的 IAR IDE 支持的用户会觉得该功能使用起来非常方便，因为 Atmel START 也使用相同的

ipcf文件来扩展对 IAR IDE 的支持。Ipcf 属于项目连接文件，是 IAR 从其他平台生成项目的标准方法。
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5. 应用示例程序

5.1 Harmony v3 中提供的示例演示
csp和 core资源库中的 apps 文件夹包含外设的示例应用程序。apps文件夹按外设进行组织。每个外设都有一个关

联的文件夹，其中提供相应外设的所有示例。每个外设可能有多个示例项目可供探究。

csp资源库中提供基于 PLIB 的示例项目。以下路径描述了 PLIB 示例项目的位置。

RTC 示例：csp > apps > rtc > rtc_periodic_timeout > firmware > select project（对于相应板）。

SPI 示例：csp > apps > spi > spi_eeprom_write_read > firmware > select project（对于相应板）。

core资源库中提供基于 DRIVER 的示例项目。此外，还提供适用于 async和 sync驱动程序类型的特定示例项目。

以下路径描述了 DRIVER 示例项目的位置。

I2C 示例：core > apps > driver > i2c > async > i2c_eeprom > firmware > select project（对于相应板）。

I2C 示例：core > apps > driver > usart > sync > usart_echo > firmware > select project（对于相应板）。

注： ASFv3 包含与 Harmony v3 类似的外设的示例项目。Atmel START 是一款基于 Web 的工具，示例项目在其中单

独列出。可以从 Atmel START 网站下载示例。

5.2 使用 Harmony v3 创建一个简单的应用程序演示
本节简要概述如何创建简单的 PLIB 演示。有关分步移植的详细信息，请参见以下文档：

• ASF3 to MPLAB Harmony 3 Migration Guide
• Atmel START to MPLAB Harmony 3 Migration Guide

以下步骤包含有关在 MPLAB Harmony v3 中创建应用程序演示的高级信息：

1. 启动 MPLAB X IDE，然后选择 New Project > 32-bit MPLAB Harmony 3 Project（新建项目 > 32 位 MPLAB
Harmony 3 项目）。

2. 框架选择：给出 MPLAB Harmony 3 文件夹的根目录位置。

3. 项目设置：指定项目的位置和名称。

4. 配置设置：指定配置的名称。

5. 选择要使用的器件。

6. 配置数据库设置：选择要为项目加载的 MPLAB Harmony 资源库。

7. MPLAB Harmony 项目将随 MPLAB Harmony 配置器一起打开。默认情况下，打开的项目图中会有一些模块添

加到项目中。

8. 添加、连接和配置模块。用户可以添加应用程序所需的外设。在项目图中连接它们，并根据应用程序要求在 UI
树中进行配置。

9. 添加和配置模块后，重新生成代码以及主文件和应用程序源文件。

10. 用户可以编写应用程序逻辑并实现应用程序功能。
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6. 附录

6.1 使用 MPLAB IDE 与目标硬件建立连接
在 Atmel Studio 中，最常用的窗口之一是 Device Programming（器件编程）。在 MPLAB X IDE 中，这些功能是通过

另一个名为 MPLAB 集成编程环境（Integrated Programming Environment，IPE）的应用程序完成的。该应用程序随

MPLAB X IDE 一起安装。用户可根据需要启动该应用程序，以此确保在目标与调试器之间正确建立连接。

用户可以使用 IPE 擦除芯片，读取 HEX 文件或将其写入到芯片，以及使用可用的应用程序映像验证内容。

熔丝编程：在 Atmel Studio 中，熔丝是单独编程的，但在 MPLAB X IDE 中则并非如此。MPLAB X IDE 允许用户查看

并生成从源文件中复制的代码（用于熔丝配置）。MPLAB X IDE 同时编程应用程序映像和熔丝。

启动 MPLAB X IDE > Windows > Target Memory Views > Configuration Bits（MPLAB X IDE > 窗口 > 目标存储器视

图 > 配置位）

6.2 GIT 的基本信息
MPLAB Harmony v3 内容通过 GitHub 提供。对于刚接触 GIT 的用户，最好先对 GIT 的含义和工作原理有一些基本的

了解。GIT 与其他版本的控制系统有所不同。它属于分布式版本控制系统，而不是集中式版本控制系统。与 SVN 不同

的是，GIT 可以极大地压缩数据。有关 GIT 的基本信息，请参见参考资料部分。

6.3 将 Atmel START 项目导入 MPLAB X IDE
请按照以下步骤将 Atmel START 项目导入 MPLAB X IDE：

1. 打开 MPLAB X IDE。
2. 选择 File > Import > START MPLAB Project（文件 > 导入 > START MPLAB 项目）。

3. 使用 Browse（浏览）选项上传.atzip文件。

4. 确保选择了正确的器件，然后选择编程工具。

5. 选择 Arm 编译器工具链。

6. 指定项目的位置，然后验证所有信息正确无误。

6.4 向 MPLAB Harmony v3 项目中添加定制链接描述文件
MPLAB Harmony v3 项目使用随 MPLAB X IDE 一起安装的默认链接描述文件。某些项目可能需要定制链接描述文

件。MPLAB Harmony v3 支持向项目中添加定制链接描述文件。请按照以下步骤在项目中包含正确的链接描述文件：

1. 选择 Project > Add Existing item > Select specific linker script（项目 > 添加现有项目 > 选择特定的链接描述文

件），然后右键单击需要链接的 Linker Files（链接器文件）文件夹。

2. 选择 Project Properties > XC32 global options > xc32-ld > Additional options > Add linker switch（项目属性 >
XC32 全局选项 > xc32-ld > 其他选项 > 添加链接器开关），以使用该链接器文件进行链接。[-T ..\..\..
\yy\xxxx.ld]

6.5 修改 PLIB 并在重新生成代码时保持不变
在极少数的用例中，需要在 PLIB 中实现特定功能或进行少量修改（例如，添加 API）。在这些情况下，用户可以根据

需要修改 PLIB。手动更改 PLIB 后，用户可以更改 PLIB 配置。在此更改之后重新生成代码时，将根据新配置更改

PLIB。

用户可使其手动更改的内容保持不变，并且仅允许在 PLIB 中更新的配置更改。为此，在出现合并窗口时，将选项

USER_ALL 更改为 ALL。USER_ALL 表示对 MPLAB Harmony 3 框架文件进行更改时不会提示用户。ALL 表示对所有

文件（包括 MPLAB Harmony 3 框架文件）进行更改时会提示用户。
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图 6-1. 在重新生成代码时保留 PLIB 中的自定义更改
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7. 参考资料
1. MPLAB X IDE：https://www.microchip.com/mplab/mplab-x-ide。
2. MPLAB X IDE 编译器许可证：https://www.microchip.com/mplab/compilers。
3. MPLAB X IDE 器件支持：http://ww1.microchip.com/downloads/en/DeviceDoc/Device_Support.pdf。
4. MPLAB Harmony v3 网页链接：https://www.microchip.com/mplab/mplab-harmony/mplab-harmony-v3。
5. MPLAB Harmony GitHub 链接：https://github.com/Microchip-MPLAB-Harmony。
6. 如何设置 MPLAB Harmony v3 软件开发框架：

http://ww1.microchip.com/downloads/en/DeviceDoc/How_to%20_Setup_MPLAB_%20Harmonyv3_
%20Software_%20Development_Framework_DS90003232A.pdf

7. ASF 网页链接：https://www.microchip.com/mplab/avr-support/advanced-software-framework。
8. MPLAB Harmony 支持的中间件：https://www.microchip.com/mplab/mplab-harmony。
9. Atmel START to MPLAB Harmony 3 Migration Guide AN（DS00005413）。

10. ASFv3 to MPLAB Harmony 3 Migration Guide（DS70005412）。

11. GIT 基本信息：https://git-scm.com/doc。
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Microchip 网站

Microchip 网站（www.microchip.com/）为客户提供在线支持。客户可通过该网站方便地获取文件和信息。我们的网站

提供以下内容：

• 产品支持——数据手册和勘误表、应用笔记和示例程序、设计资源、用户指南以及硬件支持文档、最新的软件版
本以及归档软件

• 一般技术支持——常见问题解答（FAQ）、技术支持请求、在线讨论组以及 Microchip 设计伙伴计划成员名单

• Microchip 业务——产品选型和订购指南、最新 Microchip 新闻稿、研讨会和活动安排表、Microchip 销售办事

处、代理商以及工厂代表列表

产品变更通知服务

Microchip 的产品变更通知服务有助于客户了解 Microchip 产品的最新信息。注册客户可在他们感兴趣的某个产品系列

或开发工具发生变更、更新、发布新版本或勘误表时，收到电子邮件通知。

欲注册，请访问 www.microchip.com/pcn，然后按照注册说明进行操作。

客户支持

Microchip 产品的用户可通过以下渠道获得帮助：

• 代理商或代表

• 当地销售办事处

• 应用工程师（ESE）
• 技术支持

客户应联系其代理商、代表或 ESE 寻求支持。当地销售办事处也可为客户提供帮助。本文档后附有销售办事处的联系

方式。

也可通过 www.microchip.com/support 获得网上技术支持。

Microchip 器件代码保护功能

请注意以下有关 Microchip 器件代码保护功能的要点：

• Microchip 的产品均达到 Microchip 数据手册中所述的技术规范。

• Microchip 确信：在正常使用的情况下，Microchip 系列产品非常安全。

• 目前，仍存在着用恶意、甚至是非法的方法来试图破坏代码保护功能的行为。我们确信，所有这些行为都不是以

Microchip 数据手册中规定的操作规范来使用 Microchip 产品的。这种试图破坏代码保护功能的行为极可能侵犯

Microchip 的知识产权。

• Microchip 愿与那些注重代码完整性的客户合作。

• Microchip 或任何其他半导体厂商均无法保证其代码的安全性。代码保护并不意味着我们保证产品是“牢不可破”

的。代码保护功能处于持续发展中。Microchip 承诺将不断改进产品的代码保护功能。任何试图破坏 Microchip 代

码保护功能的行为均可视为违反了《数字器件千年版权法案（Digital Millennium Copyright Act）》。如果这种行

为导致他人在未经授权的情况下，能访问您的软件或其他受版权保护的成果，您有权依据该法案提起诉讼，从而

制止这种行为。

法律声明

提供本文档的中文版本仅为了便于理解。请勿忽视文档中包含的英文部分，因为其中提供了有关 Microchip 产品性能和

使用情况的有用信息。Microchip Technology Inc.及其分公司和相关公司、各级主管与员工及事务代理机构对译文中可

能存在的任何差错不承担任何责任。建议参考 Microchip Technology Inc.的英文原版文档。

 AN3346

© 2020 Microchip Technology Inc.  应用笔记 DS00003346A_CN-第 30 页

http://www.microchip.com/
http://www.microchip.com/pcn
http://www.microchip.com/support


本出版物中提供的信息仅仅是为方便您使用 Microchip 产品或使用这些产品来进行设计。本出版物中所述的器件应用信

息及其他类似内容仅为您提供便利，它们可能由更新之信息所替代。确保应用符合技术规范，是您自身应负的责任。

MICROCHIP“按原样”提供这些信息。Microchip 对这些信息不作任何明示或暗示、书面或口头、法定或其他形式的

声明或担保，包括但不限于针对非侵权性、适销性和特定用途的适用性的暗示担保，或针对其使用情况、质量或性能

的担保。

在任何情况下，对于因这些信息或使用这些信息而产生的任何间接的、特殊的、惩罚性的、偶然的或间接的损失、损

害或任何类型的开销，MICROCHIP 概不承担任何责任，即使 MICROCHIP 已被告知可能发生损害或损害可以预见。

在法律允许的最大范围内，对于因这些信息或使用这些信息而产生的所有索赔，MICROCHIP 在任何情况下所承担的

全部责任均不超出您为获得这些信息向 MICROCHIP 直接支付的金额（如有）。如果将 Microchip 器件用于生命维持

和/或生命安全应用，一切风险由买方自负。买方同意在由此引发任何一切损害、索赔、诉讼或费用时，会维护和保障

Microchip 免于承担法律责任。除非另外声明，在 Microchip 知识产权保护下，不得暗中或以其他方式转让任何许可

证。

商标

Microchip 的名称和徽标组合、Microchip 徽标、Adaptec、AnyRate、AVR、AVR 徽标、AVR Freaks、BesTime、
BitCloud、chipKIT、chipKIT 徽标、CryptoMemory、CryptoRF、dsPIC、FlashFlex、flexPWR、HELDO、IGLOO、

JukeBlox、KeeLoq、Kleer、LANCheck、LinkMD、maXStylus、maXTouch、MediaLB、megaAVR、Microsemi、
Microsemi 徽标、MOST、MOST 徽标、MPLAB、OptoLyzer、PackeTime、PIC、picoPower、PICSTART、PIC32
徽标、PolarFire、Prochip Designer、QTouch、SAM-BA、SenGenuity、SpyNIC、SST、SST 徽标、SuperFlash、
Symmetricom、SyncServer、Tachyon、TempTrackr、TimeSource、tinyAVR、UNI/O、Vectron 和 XMEGA 均为

Microchip Technology Incorporated 在美国和其他国家或地区的注册商标。

APT、ClockWorks、The Embedded Control Solutions Company、EtherSynch、FlashTec、Hyper Speed Control、
HyperLight Load、IntelliMOS、Libero、motorBench、mTouch、Powermite 3、Precision Edge、ProASIC、ProASIC
Plus、ProASIC Plus 徽标、Quiet-Wire、SmartFusion、SyncWorld、Temux、TimeCesium、TimeHub、TimePictra、
TimeProvider、Vite、WinPath 和 ZL 均为 Microchip Technology Incorporated 在美国的注册商标。

Adjacent Key Suppression、AKS、Analog-for-the-Digital Age、Any Capacitor、AnyIn、AnyOut、BlueSky、
BodyCom、CodeGuard、CryptoAuthentication、CryptoAutomotive、CryptoCompanion、CryptoController、
dsPICDEM、dsPICDEM.net、Dynamic Average Matching、DAM、ECAN、EtherGREEN、In-Circuit Serial
Programming、ICSP、INICnet、Inter-Chip Connectivity、JitterBlocker、KleerNet、KleerNet 徽标、memBrain、
Mindi、MiWi、MPASM、MPF、MPLAB Certified 徽标、MPLIB、MPLINK、MultiTRAK、NetDetach、Omniscient
Code Generation、PICDEM、PICDEM.net、PICkit、PICtail、PowerSmart、PureSilicon、QMatrix、REAL ICE、
Ripple Blocker、SAM-ICE、Serial Quad I/O、SMART-I.S.、SQI、SuperSwitcher、SuperSwitcher II、Total
Endurance、TSHARC、USBCheck、VariSense、ViewSpan、WiperLock、Wireless DNA 和 ZENA 均为 Microchip
Technology Incorporated 在美国和其他国家或地区的商标。

SQTP 是 Microchip Technology Incorporated 在美国的服务标记。

Adaptec 徽标、Frequency on Demand、Silicon Storage Technology 和 Symmcom 为 Microchip Technology Inc.在其

他国家或地区的注册商标。

GestIC 是 Microchip Technology Inc.的子公司 Microchip Technology Germany II GmbH & Co. KG 在除美国外的国家

或地区的注册商标。

在此提及的所有其他商标均为各持有公司所有。
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质量管理体系

有关 Microchip 的质量管理体系的信息，请访问 www.microchip.com/quality。
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